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policy making. Hence, the mathematical 
methods would help economists to use 
the quantitative variables in a better way 
and to obtain accurate results.

The lengthy and descriptive 
economic contents can be clearly set in 
simple notation in mathematical models for 
clear and easy understanding. For example, 
the number of pens demanded in a given 
time period in a Higher Secondary School 
is 200 when price is zero. This decreases 
by 10 for every ₹1 rise in the price of pen. 
It is expressed mathematically as

Q = 200 - 10 P, here Q is the 
quantity demanded and P is the price.
Thus large information can be expressed 
and communicated with simple functions 
and equations.

CHAPTER

12 Mathematical Methods  
for Economics

“The master economist must possess a rare combination of gifts. He 
must be mathematician, historian, statesman, philosopher to some degree”

- J.M.Keynes

1 To understand why mathematics is required for  
economics,

2 �To learn the knowledge of mathematical methods, as a facility for self-expression 
not only in descriptive economics, but also in quantitative economics.

Learning Objectives

12.1

Introduction

Economic analysis is a systematic 
approach to (a) determine the optimum 
use of scarce resources and (b)choose 
available alternatives and select the 
best alternative to achieve a particular 
objective. Mathematical methods are 
helpful for achieving the objectives of the 
economic analysis.

12.1.1 � Why Study 
Mathematics?

The subject Economics deals with many 
quantitative variables and functions, in 
consumption, production, distribution and 
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12.1.2 � Mathematics in 
Economics

Sir William Petty 
declared that he wanted 
to reduce political and 
economic matters in 
terms of number, weight 
and measure. He was the 
first one to use 
mathematics in 
economics. The first 
known writer to apply mathematical method 
to economic problems was Giovanni Ceva 
(1711), an Italian.

12.1.3 � Uses of Mathematical 
Methods in Economics

1.	 Mathematical Methods help to 
present the economic problems in a 
more precise form.

2.	 Mathematical Methods help to 
explain economic concepts.

3.	 Mathematical Methods help to 
use a large number of variables in 
economic analyses.

4.	 Mathematical Methods help to 
quantify the impact or effect of any 
economic activity implemented by 
Government or anybody. There are 
of course many other uses.

Think and Do

�� Who is the father of 
Economics? Did he use 
any of the mathematical 
tools in his contributions? 
If yes, list out.
�� Find out the mathematical 

tools, which are used by you 
in your daily routine life.

Sir William Petty 
1623-1687

12.2

Functions

12.2.1  Definition

A function is a mathematical relationship 
in which the values of a dependent 
variable are determined by the values of 
one or more independent variables. 

Functions with a single 
independent variable are called Simple 
Univariate functions. There is a one to one 
correspondence. Functions,with more 
than one independent variable, are called 
Multivariate functions. The independent 
variable is often designated by X. The 
dependent variable is often designated 
by Y. For example, Y is function of X 
which means Y depends on X or the value 
of Y is determined by the value of X.  
Mathematically one can write Y = f(X).

12.2.2  Linear Equation

A statement of relationship between two 
quantities is called an equation. In an equation, 
if the largest power of the independent 
variable is one, then it is called as Linear 
Equation. Such equations when graphed give 
straight lines. For example Y = 100-10X.

For a straight line, there are two 
variables namely X and Y. X is called 
independent variable and Y is called 
dependent variable.

When ‘X’ value increases by one 
unit, then the corresponding change in 
the ‘Y’ value is called as the slope of the 
line. Slope of the line is obtained by the 
formula, 

m = slope (marginal change)
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2(Y-2) = -10(x-2)
2Y-4 = -10x +20

2Y = -10x+24

Y = -5x +12

-5 is slope, denoted by m

12 is Y intercept, or constant denoted by c

This is of the form Y = mX + c  

Y = 12-5X when X = 0; Y = 12

When Y = 0; X = 12/5 = 2.4

(This line looks likes demand line in micro 
economics )

12.2.3 � Application in 
Economics 

By applying the above method, the demand 
and supply functions are obtained.

Demand Function: Qd = f (Px) where Qd 
stands for Quantity demand of a commodity 
and Px is the price of that commodity.

Supply Function: Qs = f (Px) where ‘Qs’ 
stands for Quantity supplied of a commodity 
and Px is the price of that commodity.

In the example 12.1 the equation Y 
= -5X + 12 has been obtained.  It is a linear 
function. Since slope is negative here, this 
function could be a demand  function. 

2

2 4 6 8 10 12

4

6

8

10

12

0

Y=12-5X

2.4

Diagram 12.1
Quantity demanded

Pr
ic

e

	 m Y Y
X X

ChangeinY
Changein X

=
−
−

2 1

2 1

,
.

Where (X1, Y1) and (X2, Y2) are two 
arbitrary points

Slope or Gradient of the line 
represents the ratio of the changes in 
vertical and horizontal lines.

The formula for constructing a straight 
line is 

(Y - Y1) = m(X - X1)

If the two points are (0, 0) and (X, Y) then 
the formula is Y = mX

Example 12.1

Find the equation of a straight line which 
passes through two points (2, 2) and (4, -8) 
which are (X1, Y1) and (X2, Y2) respectively.

Note: For drawing a straight line, at least 
two points are required. Many straight 
lines can pass through a single point.

Solution

Here 	 X1 = 2,  Y1 = 2

X2= 4,  Y2 = -8

Formula for construction of straight line

Y Y
Y Y

X X
X X

-
-

= -
-

1

2 1

1

2 1

Applying the values

Y X

Y X

-
- -

= -
-

-
-

= -

2
8 2

2
4 2

2
10

2
2
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supply function can be obtained from the 
statement that supply increases 10 units 
for each one rupee rise in price, that is 
(10, 6) & (20, 7).

The equation of the straight line 
joining two data points (10, 6) and (20, 7) 
is given as

The equation of the straight line is 

Y Y
Y Y

X X
X X

-
-

= -
-

1

2 1

1

2 1

substituting the values of (x1, y1) (x2, y2)

by (10, 6) , (20, 7) respectively,

Y X-
-

= -
-

6
7 6

10
20 10

Y X- = -6
1

10
10

Price-quantity relationship is negative in 
demand function. Qd = 12-5 X �or Qd = 
12-5P . If P = 2, Qd = 2. 

When P assumes 0, only 12 alone 
remains in the equation. This is called 
Intercept or Constant, if P = 0 and Qd = 12.

In Marshallian analysis, money 
terms measured in Y-axis and physical 
units are measured in X-axis. Accordingly, 
price is measured in Y-axis and quantity 
demanded is measured in X-axis

Example: 12.2

Find the supply function of a commodity 
such that the quantity supplied is zero, 
when the price is ₹5 (or below) and the 
supply (quantity) increases continuously 
at the constant rate of 10 units for each 
one rupee rise when the price is above ₹5.

Solution:

To construct the linear supply function 
atleast two points are needed. First data 
point of supply function is obtained from 
the statement that the quantity supplied is 
zero, when the price is ₹5, that is (0, 5).  
The second and third data points of 
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When p = 5, supply is zero.  When p = 6, 
supply is 10 and so on.  When p is less than 
5, say 4, supply is -10, which is possible 
in mathematics. But it is meaningless 
in Economics. Normally supply curve 
originates from zero, noting that when 
price is zero, supply is also zero.
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Demand = Supply

(These are hypothetical examples)

100-10P = 50 + 10 P
100-50 = 20P

50 = 20P 
50
20

= P

P = 2.5
When P = 2.5, Demand = 100-10 (2.5)
	 = 75

When P = 2.5, Supply = 50 +10 (2.5)
= 75

Example: 12.3

Find the equilibrium price and quantity 
by using the following demand and 
supply functions Qd = 100-5P and  
Qs = 5P respectively.

Solution:

Equilibrium is attained when,

Qs = Qd

5 P = 100 - 5 P
10P = 100

P = 10
When	 P = 10
In supply function

Qs = 5 P = 5 x 10 = 50

Then	 Y X- = -6 10
10

10(Y - 6) = X - 10
10Y - 60 = X - 10
10Y - 60 + 10 = X

10Y - 50 = X
-X = -10Y + 50 

Multiplying both sides by minus (-), we get

X = -50 + 10Y
Considering X as quantity supplied and Y 
as price (P)

Then X = 10P - 50 (or)

X = -50 + 10 P

If Price = 0; Q = -50

If Q = 0; P = 5

Note: The coefficient of ‘P’ is - in demand 
function.

The coefficient of ‘P’ is + in supply 
function.

12.2.4  Equilibrium

The point of intersection of demand line and 
supply line is known as equilibrium. The 
point of equilibrium is obtained by using 
the method of solving a set of equations. 
One can obtain the values of two unknowns 
with two equations. At equilibrium point,

Diagram 12.4
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Find the linear demand function and its 
slope.

Solution: 

Equation of demand function joining two 
data points (100, 1) and (50, 2) are (x1, y1) 
and (x2, y2) respectively.

	 Y Y
Y Y

X X
X X

-
-

= -
-

1

2 1

1

2 1

	 Y X-
-

= -
-

1
2 1

100
50 100

	 Y X- = -
-

1
1

100
50

-50 (Y - 1) = 1 (X - 100)
-50Y + 50 = X - 100

-50Y + 50 + 100 = X
-50Y + 150 = X
                X = 150 - 50Y

Hence the demand function is

Qd = 150 – 50P and Slope m = – 50

Think and Do for 
Water Management in 
your area

Try to find the demand function 
for water in your street and the 
daily total demand for water in 
litre for all purposes.

In demand function,

Qd = 100 - 5 P = 100 - 5(10) = 50
Hence at

P = 10, Qd = 50, Qs = 50.

Quantity demanded is equal to supply at 
50 units when price is ₹10

Example: 12.4

The market demand curve is given by D = 
50 - 5P. Find the maximum price beyond 
which nobody will buy the commodity.

Solution:

Given
Qd = 50 - 5P
5P = 50 - Qd

5P = 50 when Qd is zero.

P =
50
5

P = 10 When P = 10, Demand is 0
Hence P = 10, which is the maximum 

price beyond which nobody will demand 
the commodity.

Example: 12.5
The demand for milk is given by 

Price (Y) 1 2 3
Demand (X) 100 50 0

Quantity Demanded

x
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e
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Diagram 12.6
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12.3 a a a
a a a
a a a

11 12 13

21 22 23

31 32 33

 is a determinant of the 

matrix A denoted by A .

The value of the determinant is expressed 
as a single number.

Calculation of the value of 
determinant for a 2 x 2 matrix is shown 
below 

If A  = 
a b
a b

1 1

2 2

 then A a b a b= −1 2 2 1

Calculation of determinant value for a  
3 x 3 matrix is shown below

a b c
a b c
a b c

a
b c
b c

b
a c
a c

c
a b
a b

1 1 1

2 2 2

3 3 3

1
2 2

3 3
1

2 2

3 3
1

2 2

3 3

= − +

= �a1(b2c3-b3c2)-b1(a2c3-a3c2)+c1(a2b3-a3b2)

Example: 12.6

Find the value of the determinant for the 

matrix A= 
3 4
10 2−










Solution:

Given matrix A = 
3 4
10 2−








 then, the 

Determinant 

A =
−

= −( ) −
3 4

10 2
3 2 10 4( )

= - 6 - 40 = - 46 is the value of the 
determinant.

Example: 12.7

Find the value of the determinant of the 
matrix

Matrices

12.3.1  Matrices

‘Matrix’ is a singular while ‘matrices’ is 
a plural form. Matrix is a rectangular 
array of numbers systematically arranged 
in rows and columns within brackets.  
In a matrix, if the number of rows and 
columns are equal, it is called a square  
matrix.

12.3.2  Determinants

For every square matrix, there exists 
a determinant. This determinant is an 
arrangement of same elements of the 
corresponding matrix into rows and 
columns by enclosing vertical lines. 

For example,    

1 3 5
6 2 4
7 8 9
















 is a square matrix of order  

3 x 3,then

1 3 5
6 2 4
7 8 9

 is a determinant.

2 3
5 7








 is a square matrix of order 2 x 2, then

2 3
5 7

 is a determinant.

In general, if A =
a a a
a a a
a a a

11 12 13

21 22 23

31 32 33
















 is a matrix 

then,
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where,	 ∆∆ =
a a a
a a a
a a a

11 12 13

21 22 23

31 32 33

∆∆ ∆∆

∆∆

x y

b a a
b a a
b a a

a b a
a b a
a b a

z

= =
1 12 13

2 22 23

3 32 33

11 1 13

21 2 23

31 3 33

, ,

==
a a b
a a b
a a b

11 12 1

21 22 2

31 32 3

Example: 12.8 

Find the value of x and y in the equations 
by using Cramer’s rule.  x + 3y = 1 and  
3x - 2y = 14

Solution:

Given equations are
 x + 3y = 1

3x - 2y = 14 
Then the equations in the matrix form :

1 3
3 2

1
14−

















 =











x
y

Calculating ∆,	  ∆∆ =
−

1 3
3 2

	 = -2 -9
	 = - 11 

∆ ≠ 0, Hence solution exists. 

∆∆ x = −
= − −

1 3
14 2

2 42  = -44

∆∆ y = = − =
1 1
3 14

14 3 11

A =
















3 4 7
2 1 3
7 2 1

Solution:

Determinant of the given matrix is,

A = = − +
3 4 7
2 1 3
7 2 1

3
1 3
2 1

4
2 3
7 1

7
2 1
7 2

	 = �3 (1 - 6) -4 (2 - 21)  
+ 7 (4 - 7)

	 = 3 (-5) -4 (-19) + 7 (-3)

	 = -15 +76 -21

A  = 40

The value of determinant is 40.

12.3.3  Cramer’s Rule

Cramer’s  rule 
provides the solution 
of a system of linear 
equations with ‘n’ 
variables and ‘n’ 
equations. It helps 
to arrive at a unique 
solution of a system 
of linear equations 

with as many equations as unknowns.
If the given equations are 

a11x + a12 y + a13 z = b1

a21x + a22 y + a23 z = b2

a31x + a32 y + a33 z = b3

then

x x y y z z
= = =
∆
∆

∆
∆

∆
∆

, ,

(1704-1752)

Key Note

If the determinant ∆∆ = 0 , then 
solution does not exist.

G. CRAMER
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Solution:

The matrix form of the given equation is 
written as 

7 1 1

10

6 3 2

0

8

7

1

2

3

x
x
x

2 1

∆∆ =
− −
− +

−

7 1 1
10 2 1
6 3 2

	 = �7(4-3)-(-1)(-20-6)+(-1)(30+12)

 = 7(1) + 1(-26) - 1(42)

= 7 -26 - 42 = -61

Δx1 = =
− −
−

−

0 1 1
8 2 1
7 3 2

= �0(4-3)-(-1)(-16-7) + (-1)(24 + 14)

= 0 + 1(- 23)-1(38)

= -23 - 38 = -61

Δx2 = =
−

−

7 0 1
10 8 1
6 7 2

= 7(-16-7)-0(-20-6)+(-1)(70-48)

= 7(-23) + 0 - 1(22)

= -161-22 = -183

Δx3 = =
−
−

7 1 0
10 2 8
6 3 7

= 7(-14-24) - (-1)(70-48) + 0(30 + 12)

= 7(-38) + 1(22) + 0

= -266 + 22 = -244

x x
1

1 61
61

1= =
−
−

=
∆∆
∆∆

Hence x x
= =

−
−

=
∆∆
∆∆

44
11

4 ,   y y
= =

−
= −

∆∆
∆∆

11
11

1

∴ =x 4 and y = −1

Example: 12.9

Find the solution of the system of equations.

5x1 + 3x2 = 30

6x1 - 2x2 = 8

Solution:

The coefficient and the constant terms are 
given below for the equations

∆

∆

∆

=
−

= − − = −

=
−

= − − = −

= = + − = −

5 3
6 2

10 18 28

30 3
8 2

60 24 84

5 30
6 8

40 180

1

2

x

x 1140

84
28

3

140
28

5

1
1

2
2

∴ = =
−
−

=

= =
−
−

=

x x

x x

∆
∆

∆
∆

∴�x1 = 3, 	 x2 = 5

Example: 12.10

Find the solution of the system of equation

7x1 - x2 - x3 = 0

10x1 - 2x2 + x3 = 8

6x1 + 3x2 - 2x3 = 7

Answer checking:
Substituting in equation the values of x 
and y,

4 + 3(-1) = 1, 

3(4) – 2(-1)= 14
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To find ∆y

∆y =	
2 32 1
4 52 2
2 60 3

∆y = − − − + −
= − +
= −

2 156 120 32 12 4 1 240 104
2 36 32 8 1 136
72 25

( ) ( ) ( )
( ) ( ) ( )

66 136 48+ = −

To find∆z

∆z = 
2 3 32
4 3 52
2 5 60

∆z = − − − + −
= − − +
= −

2( ) ( ) ( )
( ) ( ) ( )
180 260 3 240 104 32 20 6

2 80 3 136 32 14
1600 408 448 120

60
12

5

48
12

4

− + = −

=
−
−

=

=
−
−

=

x ice of a pen

y ice of a p

(Pr )

(Pr eencil

z ice of anotebook

)

(Pr )=
−
−

=
120
12

10

Answer checking

2(5)+3(4)+1(10)=32

4(5)+3(4)+2(10)=52

2(5)+5(4)+3(10)=60

Think and Do

Fathima, purchased 6 pens and 
5 Pencils spending ₹49, Rani 
purchased 3 Pens and 4 pencils 
spending ₹32. What is the price 
of a pen and pencil?

6 5
3 4

49
32

1

2


















 =











x
x

Solution : Price of a pen   = ₹4

Price of a pencil = ₹5

x x
2

2 183
61

3= =
−
−

=
∆∆
∆∆

x x
3

3 244
61

4= =
−
−

=
∆∆
∆∆

12.3.4  Application in Economics

Example 12.11

Mr.Anbu, purchased 2 pens, 3 pencils and 
1 note book.  Mr.Barakath , purchased 
4 pens, 3 pencils and 2 notebooks. 
Mr.Charles purchased 2 pens, 5 pencils 
and 3 notebooks. They spent ₹32, ₹52 and 
₹60 respectively. Find the price of a pen, a 
pencil and a note book.

Solution: 

Let x be the price of a pen, y be the price of 
a pencil and z be the price of a notebook,

In equations:

2x + 3y + 1z = 32, 
4x + 3y + 2z = 52, 
 2x + 5y +3z = 60
In matrix form

2 3 1
4 3 2
2 5 3

32
52
60

2 9 10 3 12 4 1 20

�

�

�
�
�

�

�

�
�
�

�
�

�

�
�
�

�

�

�
�
�

x
y
z

�

�

�
�
�

�

�

�
�
�

� � � � �� ( ) ( ) ( ��
� � � �
� � � � � �

6
2 1 3 8 1 14

2 24 14 12

)
( ) ( ) ( )

To find ∆x

	  ∆x =  
32 3 1
52 3 2
60 5 3

x 32 9 10 3 156 120 1 260 180
32 1 3 36 1 80

32 1

( ) ( ) ( )
( ) ( ) ( )

008 80 60
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Example: 12.12

If Y = 4, then find dy
dx

Solution:

 Y = 4, here 4 is a constant.Differentiation 
of constant function is zero.

So, dy
dx

d
dx

=
( )

=
4

0

Example: 12.13

Find the slope of the function y = 6x3 for 
any value of x.

Solution:

Given y = 6x3

Slope = dy
dx

dy

dx
= ( ) −

6 3
3 1x = 18x2 for any value of x.

Example: 12.14

What is the slope of the function y = 5x4 
when x = 10?

Solution:

Given function y = 5x4

Slope = � dy
dx

dy
dx

= ( ) −5 4 4 1x

= 20x3

When x = 10, then slope = 20 (10)3 

= 20,000, 

Therefore Slope is 20,000.

1Key Note

If the power of any non-zero real 
number is zero, it's value is 1  
x 0 = 1 when x ≠ 0

12.4

DIFFERENTIAL CALCULUS

12.4.1  Meaning

The fundamental operation of calculus 
is differentiation. Derivative is used to 
express the rate of change in any function. 
Derivative means a change in the 
dependent variable with respect to small 
change (closer to zero) in independent 
variable. 

Let the function be,

y = f(x)

Differentiating y with respect to x is,
d y
dx

df x
dx

( )
=

( )

12.4.2 � Some Standard Forms 
of Differentiation 

(Constant, addition and subtraction  
only)

1.	
d c
dx
( )

= 0 where C is a constant.

	 (Read differentiation of ‘C’ with 
respect to ‘x’ is)

2.	
d x

dx
nx

n
n( )

= −1

3.	
d x
dx

x x( )
= = =−1 1 11 1 0

4.	
d u v
dx

du
dx

dv
dx

+( )
= +

5.	
d u v
dx

du
dx

dv
dx

−( )
= −
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12.4.4  Marginal concepts

Marginal concept is concerned with 
variations of Y (on the margin of X), that is, it 
is the variation corresponding in Y to a very 
small variation in X. (X is the independent 
variable and Y is the dependent variable)

12.4.5  Marginal Product 

Marginal product of a factor of production 
refers to addition to total product due to 
the use of an additional unit of a factor.

MP = d(TP)/dQ = ∆TP/∆Q 

12.4.6  Marginal Cost

Marginal cost is an addition to the total 
cost caused by producing one more unit of 
output. In symbols:

MC = d(TC)
dQ

 or MC = Δ(TC)
ΔQ

Where, ∆TC represents a change in total 
cost and ∆Q represents a small change 
in output or quantity. (in economics one 
worker, one output etc are assumed to be 
very small units)

Example: 12.17

Given the total cost function, TC = 15 + 3Q2 
+ 7Q3, drive the marginal cost function.

Solution:

TC = 15 + 3Q2 + 7Q3 

MC
d
dQ

d Q
dQ

d Q
dQ

=
( )

+
( )

+
( )15 3 72 3

   = 0+3(2)Q2-1 + 7(3)Q3-1

MC = 6Q +21Q2

Example: 12.15

Differentiate the function Y = 3x2 + 16x3 
with respect to x.

Solution:

Y = 3x2 + 16x3

Differentiating, 
dy
dx

x x= ( ) + ( )− −3 2 16 32 1 3 1

= +6 481 2x x

dy
dx

x x= +6 48 2

Example: 12.16

If Y = 2x3 -6x, then find dy
dx

Solution: 

Y = 2x3 -6x

Differentiate ‘y’ with respect to x,
dy
dx

x x= ( ) − ( )− −2 3 6 13 1 1 1

= −6 62 0x x

dy
dx

x= −6 62

12.4.3 � Application of 
Differential Calculus

The relation between two or more 
variables can be expressed by means 
of a function. Continuous functions 
alone are differentiable. For instance, 
the differential calculus is applicable for 
finding the following:

(1)	 The rate of change in demand with 
respect to price (in micro economics)

(2)	 The rate of change in income with 
respect to the investment. (in 
macroeconomics) .
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MC (Q) = 
d TC
dQ
( ) = 3Q3-1 - 18(2)Q2-1  

+ 91(1)Q1-1+0

= 3Q2 - 36Q1 + 91Q0 + 0

MC (Q) = 3Q2 - 36Q + 91   (∴Q0 = 1)
When Q = 3

MC(Q) = 3(32)-36(3)+91
= 3(9)-108+91
= 27-108+91

=118-108
=10

To find AVC 

Given TC(Q)= Q3 - 18Q2 + 91Q + 10
We know TVC (Q)   = Q3 - 18Q2  

+ 91Q (∴constant value is fixed cost)
AVC(Q)=TVC(Q)/Q

AVC(Q) = Q2 – 18Q + 91

When Q = 3
AVC(Q) = 32–18(3)+9
               =9–54+91
               =100–54 = 46

∴AVC(Q) = Q Q Q
Q

3 218 91− +

	        =Q2 -18Q +91

Note : 	 Fixed cost= 10

		  Average fixed cost = 10
Q

. 

Average cost = Q Q Q
Q

3 218 91 10− + +

	 = − + +Q Q
Q

2 18 91 10

So Average cost = AVC + AFC

AC = AVC + AFC

                     AC  = TC
Q

12.4.7  Marginal Revenue

Marginal Revenue is the revenue 
earned by selling an additional unit of 
the product. In other words, Marginal 
Revenue is an addition made to the total 
revenue by selling one more unit of the  
good.

MR
d TR
dQ

or TR
Q

=
( )

= �∆∆
∆∆

Where ∆TR stands for change in the total 
revenue, and ∆Q stands for change in output. 

Example: 12.18	

Given TR = 50Q - 4Q2,find marginal 
revenue when Q = 3.

Solution:

TR = 50Q - 4Q2

MR = d(TR)/dQ

MR = 50(1)Q1-1 - 4(2)Q2-1

= 50(1)Q0 - 8 Q1

= 50(1) - 8Q  (∴Q0 = 1,Q1=Q)

MR = 50 - 8Q

When Q = 3 

MR = 50 -8(3) =26

Example: 12.19

A producer has the total cost function  
TC (Q) = Q3 - 18Q2 + 91Q + 10 where costs 
are given in rupees. Find the marginal 
cost (MC) and the average variable cost 
(AVC), when Q =3.

Solution:

Given TC(Q) = Q3 - 18Q2 + 91Q + 10, To 
find MC differentiate the function with 
respect to Q.
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12.4.8  Elasticity of Demand

Elasticity of Demand is the ratio of 
the proportionate change in quantity 
demanded to the proportionate change in 
price.  In mathematical terms, 

ed  = ( P
x

)  ( dx
dp

)

In demand function Q = a–bP
ed = (dQ/dP)(P/Q)

Example 12.21
If the demand function is x = 100

P
,find ed  

with respect to price at the point where P = 2

Solution:

Given

x
P

P= = −100 100 1

∴ = −
dx
dp

100 1( )P-1-1

= −100 1( )P-2

= -100(P-2)

=
−100

2P

At P=2,

dx
dp

= =
-100

4
-25  and x = =

100
2

50

Substituting the values in formula 

e Pdx
xdpd = = 







−






 =

−
= −

2
50

100
4

200
200

1

ed = -1

Note

By taking supply function, the 
elasticity of supply can be calculated

Example: 12.20

A manufacturer estimates that, when units 
of a commodity are produced each month 
the total costs will be TC(Q) = 128 + 60Q 
+ 8Q2 Find the marginal cost, average cost, 
fixed cost, variable cost, average fixed cost 
and average variable cost. 

Solution:

Given that TC(Q) = 128 + 60Q + 8Q2

We know TC = Fixed cost + variable 
cost 

MC (Q) = 
d TC
dQ
( )

= 0 + 60(1)Q1-1 + 8(2)Q2-1

= 0 + 60Q0 + 16Q1(Since, Q0=1)

MC = 60 + 16Q

AverageCost TC
Q

� =

= 128 60 8 2+ +Q Q
Q

AC = 128
60 8

Q
Q+ +

Constant value is known as fixed cost

Fixed cost = 128	

FC  = 128

Average Fixed cost = 128
Q

AFC = 128
Q

Average Variable cost =60 + 8Q (total 
variable cost divided by Q)

∴�AVC = 60 + 8Q
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12.5

Integral Calculus

12.5.1  Integration

Differential calculus measures the rate of 
change of functions. In Economics it is 
also necessary to reverse the process of 
differentiation and find the function F(x) 
whose rate of change has been given. This 
is called integration. The function F(x) is 
termed an integral or anti- derivative of 
the function f(x).

The integral of a function f(x) is 
expressed mathematically as

∫ ( ) = ( ) +f x dx F x C

Here the left hand side of the equation is 
read “the integral of f(x) with respect to 
x” The symbol ∫ is an integral sign, f(x) is 
integrand, C is the constant of integration, 
and F(x)+c is an indefinite integral.  It is 
so called because, as a function of x, which 
is here unspecified, it can assume many 
values.

12.5.2   Meaning	

If the differential coefficient of F (x) with 
respect to x is f(x), then an integral of f(x) 
with respect to x is F(x). It is a reverse 
process of differentiation. In symbols: 

If 
d F x
d

f x
x

( )  = ( ) , then�∫ ( ) = ( ) +f x dx F x C

Following points need to be remembered:

a.	 ∫ is used to denote the process of 
integration. In fact, this symbol is an 
elongated ‘S’ denoting sum.

b.	 The differential symbol ‘dx’ is written 
by the side of the function to be 
integrated.

c.	 ∫ ( )f x dx = F(x)+C, C is the integral constant 

∫ ( )f x dx means, integration of f(x) with 
respect to x.

12.5.3 � Basic Rule of Integration

(i)	 Power Rule ∫xn dx = x
n

C
n( )+

+
+

1

1
(ii)	 ∫ = kx + ck dx , where k is a constant

(iii)	∫a.xn dx = a∫xn dx

Example 12.22

4 43 3x dx x dx= ∫∫
=

+
+

+

4
3 1

3 1x c

= +4
4

4x c

= x c4 +

Example12.23

( )x x dx x dx xdx dx2 21+ − = + − ∫∫∫∫

=
+

+
+

− +
+ +x x x c

2 1 1 1

2 1 1 1

= x x x c
3 2

3 2
+ − +

Example 12.24

5 5dx x c= +∫
Example12.25

4 4
1 1

4
2

2

1 1

2

2

xdx x c

x c

x c

=
+

+

= +

= +

∫
+
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TC = ∫ +y dx c�

= ( ) ,23 16 3
2x x dx c   

where c is a constant

= ∫ ∫ ∫+ −23 16 3 2dx xdx x  dx+c

= 23x+16 x x c
2

3
3

2 3

TC = 23x + 8x2 - x3 + c 
c = 40 given
∴TC = 23x+8x2-x3 + 40

Average cost function = TC
x

= 23 + 8x - x2 + 40
x

12.5.5  Consumer’s Surplus 

This theory was developed by the Alfred 
Marshall. The demand function P(x) 
reveals the relationship between the 
quantities that the people would buy at 
given price. It can be expressed as 

P = f (x)
Consumer surplus is the difference 
between the price one is willing to pay and 
the price that is actually paid.

It is represented in the following 
diagram.

12.5.4 � Application of 
Integration

Example 12.26

Let the marginal cost function of a firm 
be 100-10x+0.1x2 where x is the output. 
Obtain the total cost function of the firm 
under the assumption that its fixed cost 
is ₹500.

Solution 

MC = 100 - 10x + 0.1 x2

TC = 100 10x 0.1 2x d x

= 100x-10 x x c
2 3

2
0 1

3
+ +.

= 100x-5x x c2
3

30
+ +

Fixed cost is given as ₹500

∴ = − + +TC x x x100 5
30

5002
3

= − + +
x x x

3
2

30
5 100 500

Example 12.27

The marginal cost function for producing 
x units is y = 23 + 16x - 3x2 and the total 
cost for producing zero unit is ₹40. Obtain 
the total cost function and the average 
cost function.

Solution:

Given the marginal cost function y = 23 + 
16x - 3x2 ; c = 40 

₹40 is the fixed cost.

We know that 

Total Cost function = ∫ (Marginal cost 
function) dx+c

Quantity Demanded
Quantity Supplied

Pr
ic

e

2        4          6        8        10     12

1

2

3

Y

X0

Pr
ic

e

      5          10          15         20  

2

1

4

6
7

8

Y

x

3

5

0

(0,5)
(10,6)

(20,7)

Demand/Supply

Pr
ic

e

      25          50         75         100  

2.5

5

7.5

10

Y

S

E

x0

D

x

Demand

Pr
ic

e

      25          50           75         100  

   5

10

15

20

Y

S

E

0

D

X

Demand

Pr
ic

e

        50         100        150        200  

  1

 2

  3

 4

Y

0

x
Demand

Pr
ic

e

         1         2         3        4

  10

  20

  30

 40
Y

0

35

CS Area =27 units

D

x

x
Demand / Supply

Pr
ic

e

      2     4       6      8     10                   

Y

0

5
10

15

20

25

D

S

CS = 42.67

PS= 16

Demand

Demand curve 

Pr
ic

e

Y

0

P0
B  

X0

Consumer’s surplus

xDemand

Demand curve 

Pr
ic

e

Y

0

,P0)P0
B  

X0

(X0

Consumer’s surplus

(2,2)

(12,0)

Diagram 12.2

Diagram 12.8

Diagram 12.3 Diagram 12.5 Diagram 12.6 Diagram 12.7

(X0,P0)

�nal
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Example 12.29
Given the demand function Pd = 25 - Q2  
and the supply function Ps = 2Q + 1. 
Assuming pure competition, find (a) 
consumers surplus and (b) producers surplus. 
(Pd = Demand price; Ps = Supply price)

Solution:

For market equilibrium, P Pd s=

25-Q2 = 2Q+1

0 = -25 + Q2 + 2Q+1

0 = -24 + Q2 + 2Q

Q2 + 2Q - 24 = 0

Q2 + 6Q - 4Q - 24 = 0

Q(Q + 6) -4(Q + 6) = 0

(Q + 6)(Q- 4) = 0
So, Q = 4 or Q = -6. Since Q cannot be 
equal to -6, 

Q = 4

When Q=4,  Pd =25 -42=9;

Ps =2(4) + 1=9

Consumers’ surplus = 
0

4

�(25 - Q2)dQ - 
(9 X 4)

= 25Q - Q
3

3







 −

0

4

36

=[ (25)(4) - 1
3

 (4)3 ] -(0) -36

= [100 - 64
3

 ] - (0) -36 = 42.67

Producers’ surplus PS

(PS) = (9×4) - 
0

4

�( 2Q+1)dQ

= 36 - (Q +Q)2 0

4

= 36 - (16 + 4) = 16

Mathematically, the consumer’s surplus 
(CS) can be defined as 

CS = (Area under the demand 
curve from x = 0 to x = x0) - (Area of the 
rectangle OX0BP0)

CS = [
0

0x

p x dx]-x0p0

Example:12.28

If the demand function is P = 35 - 2x - x2 
and the demand x0 is 3, what will be the 
consumer’s surplus?

Solution 

Given demand function,

P = 35 - 2x - x2

for x = 3
P = 35 - 2(3) -32

= 35 - 6 - 9
P = 20

Therefore,

CS = (Area of the curve below the 
demand curve from 0 to 3) - Area of the 
rectangle (20 x 3 = 60)

CS = 
0

3

�(35-2x-x2)dx-(20×3)

= 35 2
2 3

2 3

0

3

x x x
− −









 -60

= 35(3) -2(3
2

2

) - 3
3

3

 -60

= 105 -9 -9 - 60
= 27 Units.

12.5.6  Producer’s surplus 

PS = Po xo - g x x
o

xo
( )dò
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12.6

S.No Information Technologies

5 Transmission Internet, 
Teleconference, 
Video 
conferencing, 
Mobile 
Technology, Radio

6 Exchange	 E mail, Cell phone

The evaluation of ICT has five phases. 
They are evolution in

(a)	 Computer
(b)	 PC
(c)	 Microprocessor
(d)	 Internet and
(e)	 Wireless links

In Economics, the uses of mathematical 
and statistical tools need the support 
of ICT for data compiling, editing, 
manipulating and presenting the results. 
In general, SPSS and Excel packages are  
often used by researchers in economics.  
Such Software is designed to do certain 
user tasks.Word processor, spread 
sheet and web browser are some of the 
examples which are frequently used while 
undertaking analysis in the study of 
economics. 

12.6.1  MS Word

MS word is a word processor, which helps 
to create, edit, print and save documents 
for future retrieval and reference.

The features of word 
processor are 

a)	 Document can be created, copied, 
edited and formatted.

Think and Do

�� Find your change in 
mark by additional hour 
of study in any of your 
subject
�� Find your consumption 

of petrol for an additional 
unit of kilometer travelled
�� Ask your parents about 

their spending with 
respect to every additional 
unit of wage or salary or 
income

Information and 
Communication  
Technology (ICT)

Information and Communication 
Technology (ICT) is the infrastructure 
that enables computing faster and 
accurate. The following table gives an idea 
of range of technologies that fall under the 
category of ICT.

S.No Information Technologies

1 Creation Personal 
Computers, Digital 
Camera, Scanner, 
Smart Phone

2 Processing Calculator, PC, 
Smart Phone

3 Storage CD, DVD, Pen 
Drive, Microchip, 
Cloud

4 Display PC, TV, Projector, 
Smart Phone
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12.6.2  Microsoft Office Excel

It is used in data analysis by using 
formula. A spread sheet is a large sheet 
of paper which contains rows and 
columns. The intersection of rows and 
columns is termed as ‘cell’. MS Excel 
2007 version supports up to 1 million 
rows and 16 thousand columns per  
work sheet.

Start

You can start excel from various  
options.

�� Click Start → Program → Micro Soft 
Excel.
�� Double Click the MS Excel Icon from 

the Desk top.

Work Sheet

A worksheet is a table like document 
containing rows and columns with data 
and formula. There are four kinds of 
calculation operators. They are arithmetic, 
comparison, text concatenation (link 
together) and reference. MS Excel helps to 
do data analysis and data presentation in 
the form of graphs, diagrams, area chart, 
line chart etc. 

12.6.3  Microsoft Power Point

It is a software used to perform computer 
based presentation.

Steps involved in making 
presentation:

	 (i)	Click Start Menu
	 (ii)	Click Program

b)	 Words and sentences can be inserted, 
changed or deleted.

c)	 Formatting can be applied.
d)	 Margins and page size can be adjusted.
f)	 Spell check can be availed.
g)	 Multiple documents – files can be 

merged.

How to open a word 
Document?

One can open MSWord from various 
options.

Click start → All program → MS 
word or Double click the MS word icon 
from the desktop.

Uses of Menu 

Home menu → It is used to change the 
fonts, font size, change 
the text color and apply 
text style bold, italic, 
underline etc.

Insert → It is used to insert page 
numbers, charts, tables, 
shapes, word art forms, 
equations, symbols and 
pictures.

Page Layout → It is used to change the 
margin size, split the 
text into more columns, 
background colour of a 
page.

Reference → Insert table of authors, 
endnote, footnote

Review → Spell check, Grammar, 
Translate.

View → Print layout, full screen 
reading, document view
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CONCLUSION 

This chapter provide the knowledge of 
necessity of mathematics in economics 
by explaining the application of linear 
algebra, calculus and Information 
Communication and Technology. 
Specifically the knowledge of functions, 
matrices , differential calculus, Integral 
calculus ,MS word, MS Excel and Power 
Point Presentation are depicted with 
suitable applications. The activities are 
also added for students to learn it reality 
about the use of mathematical methods  in 
economics. 

FORMULAE

1.	 m= y2-y1/x2-x1  for Slope
2.	 (y-y1) = m (x-x1 ) for  straight Line
3.	 A  = a1(b2c3 – b3c2) – a2(b1c3-

b3c1)+a3(b1c2-b2c1) for 3x3 
matrices

4.	 Differentiation of constant is 
zero

5.	 Differentiation of xn is nx(n-1)

6.	 ed = Marginal function / Average 
function

7.	 ed = −P
x

dx
dp

8.	 Integration of xn is x
n

C
n+

+
+

1

1

9.	 CS= f x dx x p
x

o o( )
0

0

∫











−

10.	 PS = x0p0 – integration of 
supply function within limit 

= x po o-
0

0x

g x dx∫ ( )

	 (iii)	Select Microsoft Power point – 
Click.

	 (iv)	 �New Power Point file will open, and 
then type the title and subtitle if 
wanted.

	 (v)	A new slide can be inserted by ‘click’ 
on icon ‘new slide’ or using short 
key ‘Ctrl + M’

	 (vi)	 �We can type the content, insert the 
table, pictures, movies, sounds, 
etc., with the content.

	(vii)	 �Tab ‘Design’ helps to design the 
slides (can select common design for 
all slides or separate slide for each 
slide)

	(viii)	Click icon slide show, one can run 
slide show either starting from 
the first slide or starting from the 
current slide.  

The power point presentation (PPT) 
facilitates the key points to be kept in 
memory and understand the particular 
topic. Recently, the smart class room 
teaching uses the PPT to deliver the 
information in an effective way to enhance 
the quality of teaching.

Think and Do

�� Make a Document with 
MS word on “Incredible 
India”.
�� Prepare an Excel Sheet for 

your daily pocket expenses 
for each category/item in 
last month 
�� Prepare and present a 

“Power Point” for “Day 
out with your parents” 
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Drawing Graphs for the Data Collected

Graphs using EXCEL for 
the given data is given

Steps:
• �Collection of data of Child population (0-6 years) from 1961 to 2011 in Rural and Urban areas in India. 

Let us draw the graph for the data.
• �Open Microsoft Excel workbook, Type the X-axis data in the First column and then type respective 

data in consecutive columns.
• �Now select all the typed data, After selecting the data Click “Insert” to get Charts. select scatter type to 

get scroll down menu. 
• �Select “Scatter with Smooth Lines and Markers” you will get the required graph as shown here.
• �By selecting 3 icons on the right side to edit “chart elements” Particularly Check on the boxes Axis 

Titles and Chart Title.
• �Type x-axis and y-Axis, followed by Chart Title. Click “Legend” to change the position
• �Now right click on the graph (a) to copy the graph and Then paste in a word page (or)Select move chart 

to move In other excel page, Menu willappear to place it in new sheet.
• �Now If you want to change the graph type as bar chart or any other type,click on the graph to select and 

then click on any type of graph given in the top menu

URL:
https://youtu.be/Xn7Sd5Uu42A

(or) scan the QR Code

ICT CORNER

Step4

Step8

Step3

Step7

Step2

Step6

Step1

Step5
Pictures are indicatives only*
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Consumer’s and Producer’s Surplus

Lets use Integration to find 
Consumer’s and Producer’s 

Surplus

Steps:
• �Open the Browser type the URL given (or) Scan the QR Code.
• �GeoGebra Work book called “XI STD ECONOMICS” will appear, Open the worksheet named 

“Consumer’s and Producer’s Surplus Ex:12.29”
• �Without integration we cannot find the Area under the curve. For Higher studies atleast you should 

know what is Integration and why it is needed. 
• �In the worksheet Green colour is the Demand Curve and Blue colour is the Supply curve. They intersect 

at Point A (4,9). In which x axis value 4 is the demand price. If you integrate the Demand curve 
between 0 and 4 we get the area as shown. Click “Show Area Integral1”  integrating the demand price 
between 0 and 4.

• �If you click on “Show Area of Rectangle” you can see the area of the rectangle which is obtained by 
Multiplying the length 4 and Breadth 9 (Point A(4,9))

• �If you subtract: the area under the curve PD -Area of the rectangle you 
get the Consumer’s Surplus.

• �Click on “Show Area Integral 2” you see Blue colour area which is 
obtained by Integrating Supply Price line between 0 and 4. Subtract: 
Area of the rectangle – Area under the line PS you get The Producer’s 
Surplus. You can change PS line by moving the sliders ‘m’ and ‘c’. you 
can see the changes in Consumer’s Surplus and Producer’s Surplus.

URL:
https://ggbm.at/ddY3wkjp

(or) scan the QR Code

ICT CORNER

Step4Step3Step2Step1

Pictures are indicatives only*
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Part-A  Multiple Choice 
Questions

	 1.	 Mathematical Economics is the 
integration of

a.	 Mathematics and Economics

b.	 Economics and Statistics

c.	 Economics and Equations

d.	Graphs and Economics

	 2.	 The construction of demand line or 
supply line is the result of using

a.	 Matrices

b.	 Calculus

c.	 Algebra

d.	Analytical Geometry

	 3.	 The first person used the mathematics 
in Economics is

a.	 Sir William Petty

b.	 Giovanni Ceva

c.	 Adam Smith

d.	 Irving Fisher

	 4.	 Function with single independent 
variable is known as

a.	 Multivariate Function

b.	 Bivariate Function 

c	 Univariate Function

d.	Polynomial Function

M O D E L  Q U E S T I O N S

	 5.	 A statement of equality between two 
quantities is called

a.	 Inequality

b.	 Equality

c.	 Equations

d.	Functions

	 6.	 An incremental change in dependent 
variable with respect to change in 
independent variable is known as 

a.	 Slope		  b.  Intercept

c.	 Variant	 d.  Constant

	 7.	 (y - y1) = m(x - x1)  gives the 

a.	 Slope

b.	 Straight line

c.	 Constant

d.	Curve

	 8.	 Suppose D = 50 - 5P. When D is zero 
then 

a.	 P is 10		 b.	 P is 20

c.	 P is 5		  d.	 P is -10

	 9.	 Suppose D = 150 - 50P. Then, the 
slope is

a.	 -5	 b.	 50

c.	 5	 d.	 -50

	10.	Suppose determinant of a matrix 0,  
then the solution 

a.	 Exists

b.	 Does not exist

c.	 is infinity

d.	 is zero
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	11.	State of rest is a point termed as 

a.	 Equilibrium

b.	 Non-Equilibrium 

c.	 Minimum Point

d.	Maximum Point

	12.	Differentiation of constant term 
gives 

a.	 one

b.	 zero

c.	 infinity

d.	non-infinity

	13.	Differentiation of xn is 

a.	 nx(n-1)

b.	 n x (n+1)

c.	 zero

d.	one

	14.	Fixed Cost is the -----------term in cost 
function represented in mathematical 
form.

a.	 Middle

b.	 Price

c.	 Quantity

d.	Constant 

	15.	The first differentiation of Total 
Revenue function gives

a.	 Average Revenue

b.	 Profit 

c.	 Marginal Revenue 

d.	Zero

	16.	The elasticity of demand is the ratio of 

a.	 Marginal demand function and 
Revenue function 

b.	 Marginal demand function to 
Average demand function

c.	 Fixed and variable revenues

d.	Marginal Demand function and 
Total demand function

	17.	If x+y = 5 and x-y= 3 then, Value  
of x

a.	 4

b.	 3

c.	 16

d.	8

	18.	Integration is the reverse process of 

a.	 Difference

b.	 Mixing

c.	 Amalgamation

d.	Differentiation 

	19.	Data processing is done by 

a.	 PC alone

b.	 Calculator alone 

c.	 Both PC and Calculator

d.	Pen drive

	20.	The command Ctrl + M is applied for 

a.	 Saving

b.	 Copying

c.	 getting new slide

d.	deleting a slide
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Part-A  Answers

1 2 3 4 5 6 7 8 9 10
a d b c c a b a d b

11 12 13 14 15 16 17 18 19 20
a b a d c b a d c c

Part – B  Answer the following questions in one or two 
sentences:

	21.	 If 62 = 34 + 4x what is x? (Answer :x is 7)

	22.	Given the demand function q = 150 − 
3p, derive a function for MR.

	23.	Find the average cost function where 
TC = 60 + 10x +15x2

	24.	The demand function is given by x = 
20 - 2p - p2 where p and x are the price 
and the quantity respectively. Find the 
elasticity of demand for p = 2.5.

	25.	Suppose the price p and quantity q 
of a commodity are related by the 
equation q = 30 - 4p - p2 find (i) ed at 
p = 2 (ii) MR 

	26.	What is the formula for elasticity 
of supply if you know the supply 
function?

	27.	What are the Main menus of MS 
Word?

Part – C  Answer the following questions in one paragraph:

	28.	Illustrate the uses of Mathematical 
Methodsm in Economics.

	29.	Solve for x quantity demanded if 16x − 
4 = 68 + 7x. (Ans: x is 8 )

	30.	A firm has the revenue function R = 
600q - 0.03q2 and the cost function 
is C = 150q + 60,000, where q is the 
number of units produced. Find AR, 
AC, MR and MC. (Answersa:AR = 600 
- 0.03q ; MR = 600 - 0.06 q; AC = 150 
+ (60000/q) )

	31.	Solve the following linear equations 
by using Cramer’s rule.

	 	 x1 - x2 + x3 = 2:  x1 + x2- x3 = 0 :   
-x1- x2 - x3 = -6

	32.	If a firm faces the total cost function 
TC = 5+ x2 where x is output, what is 
TC when x is 10?

	33.	If TC = 2.5q3− 13q2+ 50q + 12 derive 
the MC function and AC function.

	34.	What are the steps involved in 
executing a MS Excel Sheet?
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Part – D  Answer the following questions in about a page:

	35.	A Research scholar researching the 
market for fresh cow milk assumes 
that Qt= f(Pt, Y,A,N, Pc) where Qt 
is the quantity of milk demanded, 
Pt is the price of fresh cow milk, Y 
is average household income, A is 
advertising expenditure on processed 
pocket milk, N is population and Pc is 
the price of processed pocket milk .

(a)	� What does Qt= f (Pt, Y,A,N, Pc) 
mean in words?

(b)	� Identify the independent 
variables.

(c)	� Make up a specific form for this 
function. (Use your knowledge 
of Economics to deduce whether 
the coefficients of the different 

independent variables should be 
positive or negative.)

	36.	Calculate the  elasticity of demand 
for the demand schedule by using 
differential calculus method P = 60 − 
0.2Q where price is (i) zero, (ii) ₹20, 
(iii) ₹40.

	37.	The demand and supply functions 
are pd=1600 - x2 and ps = 2x2 + 400 
respectively. Find the consumer’s 
surplus and producer’s surplus at 
equilibrium point. 

	38.	What are the ideas of information and 
communication technology used in 
economics?

	1.	� The petrol consumption of your car is 16 Kilometers per litre. 
Let x be the distance you travel in Kilometers and p the price 
per litre of petrol in Rupees. Write expressions for demand for 
Petrol.

	2.	� Make up your own demand function and then derive the 
corresponding MRfunction and find the output level which 
corresponds to zero marginal revenue.

	3.	� Use an Excel spreadsheet to calculate values for Quantity of 
demand at various prices for the function Q = 100−10P then 
plot these values on a graph.

	4.	� Open MS-Word and put the title as PRESENT AND ABSENT 
OF STUDENTS and insert the table and collect the data for all 
classes of your school and find the class of highest absentees  in 
a  month. Justify with reason for the absentees in a paragraph 
by using MS Word.

ACTIVITY
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